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95 Tips for Windows 95

as seen in Computer Life. Used with permission.
Written by Kay Yarborough Nelson, author of the book, Voodoo Windows.

MANAGING YOUR DESKTOP

1 Press F1 for a quick trip to Help.

2 Click on the Start button at the lower left corner of the screen to open programs or 
recently viewed documents, change settings, find files, or get help.

3 Right-click on an icon to see a pop-up menu, which allows you to perform operations (cut,
paste, rename) on the application, folder, or file.

4 Right-click in a dialog box to display a What's This? help box.  Click in the What's This? 
box to bring up an explanation of the dialog-box feature.  Click again to close the 
explanation box.

5 Press the Escape key to close an open menu.

6 Press Alt+Escape to cycle through the Taskbar buttons without using the mouse.  This 
brings windows that correspond to the Taskbar buttons to the foreground, one by one.

7 Press Alt+Tab to show a box in midscreen with icons representing open applications and 
folders.  Hold down the Alt key and hit Tab to select an icon.  Release both keys to open 
your selection.

8 To move a window around the screen, drag it by its title bar.

9 Click on the minimize button in the upper right corner of a window to minimize the 
window.  Minimizing hides the window and creates a button for the window on the 
Taskbar.

10 Click on the maximize button in the upper right corner of a window to maximize the 
window.

11 When a window is maximized, click on the restore button in the upper right corner to 
make it smaller.

12 Press Alt+F4 or click on the close button in the upper right corner of a window to close it.

13 To open the window of an active file, folder, or application, click on its Taskbar button.

14 To retrieve a recently opened file, click on the Start button, highlight Documents in the 
pop-up menu, and choose the name of the file you want from the pop-up list.

15 Drag the Taskbar by its upper edge to enlarge it.
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16 To close an application via a pop-up menu, double-click on the icon that represents the 
open application, which is located in the upper left corner of its window.  

17 To print, drag an unopened file to the printer icon located in the printer folder on My 
Computer.

18 Right-click on the desktop.  In the pop-up menu that appears, choose Properties to 
choose your screen saver, window appearance, and background wallpaper.

19 Click on the Start button and click on Shut Down in the pop-up menu to exit Windows 95.

21 Reposition the Taskbar by clicking on it and dragging your cursor to the edge of the 
screen where you would like the Taskbar to appear.

22 Double-click on a window's title bar to maximize the window.

23 Drag a document to an application's button on the Taskbar to open the application.  Drop 
the document in the application's window to work with that file.  Don't release the mouse 
button until you've dropped the file into the open window.

24 Click on an icon on the desktop or in My Computer and press Alt+Enter, or right-click on 
the icon and select Properties.  The Properties dialog box tells you whether the icon 
represents an application, folder, or file; which drive it's located on; when it was created; 
its size; and more.

25 Within a dialog box, press Tab to move between the options instead of clicking with the 
mouse.

26 In a dialog box with more than one folder tab at the top, press Ctrl+Tab to move to 
another folder tab instead of using the mouse.

27 When an option within a dialog box is highlighted, press the space bar instead of clicking 
with the mouse on the box to select that option.  Repeat the action to deselect it.

28 Click on an icon on the desktop or in My Computer to highlight it, and press Shift+F10 to 
open a pop-up menu.

29 Press Ctrl+Escape to bring up the Start button without hunting for the Taskbar.

30 Press F3 for a quick trip to Find.

31 Drag the mouse to an edge or corner of an active window.  When the cursor turns into a 
line with arrows on either end, click the left mouse button and drag the window to resize 
it.

32 To make an application, folder, or file easily accessible, place it on the Start menu by 
right-clicking and dragging it onto the Start button.

33 To clear the desktop, right-click on the Taskbar and choose Minimize All Windows.

34 To open all the windows of active files, folders, and applications, right-click on the 
Taskbar, choose Minimize All Windows, right-click again, and choose Undo Minimize All.  
If lots of windows were minimized, this saves you from opening the files individually.
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35 Right-click on a button on the Taskbar and choose Close to exit an application.

36 Right-click on a Taskbar button and press Alt+F4 to close the application, folder, or file.

37 Click just above the scroll-down arrow to move through a document one page at a time.

38 To reset your system's date and time, click on the Start button, highlight Settings, click on 
the Control Panel icon, and double-click on the Day/Time icon.

39 In the Day/Time Properties box, click the Time Zone tab.  On the world map, drag the 
light bar over your location.

40 Highlight some text or an image in a an application that supports OLE, then drag it to the 
desktop.  It appears as a "Scrap."  Now drag the Scrap into another OLE program's open 
window to create an embedded object.

41 Create customized desktops (for example, one for work and another for weekends) and 
access them with different passwords.  Click on the Start button, highlight Settings, and 
click on the Control Panel icon.  Double-click on Passwords and click on the User Profiles
tab.  Click on  "Users can customize their preferences and desktop settings."  Click on 
OK.  Windows 95 tells you to restart the computer.  At the Welcome screen, you'll type a 
user ID and password of your choice.  Windows 95 will ask you to confirm the password 
by typing it a second time.  Windows 95 will remember the changes you make to your 
desktop.  To create another desktop: shut down, restart, and enter a new user ID and 
password.

42 Put the Desktop folder on the Start button, where it's easy to access with Ctrl+Escape.  
The Desktop folder is normally hidden inside the Windows folder. So, in My Computer or 
the Explorer window, go to the drive where you've put Windows 95.  Click on the 
Windows folder, and choose Options from the View menu.  Click on the View tab and 
click Show All Files.  Click on OK.  Click on your Windows 95 folder and locate the 
Desktop folder.  Drag the Desktop folder to the Start menu button.

EXPLORING THE EXPLORER AND MY COMPUTER

43 To open the Explorer, right-click on the Start button and choose Explorer from the pop-up 
menu.

44 To go to the Explorer, right-click the Recycle Bin or My Computer and choose Explorer 
from the pop-up menu.

45 To open an application, folder, or file directly from the desktop instead of searching for it 
in the Explorer or in My Computer, create a shortcut.  Right-click and drag an application, 
folder, or file from the Explorer to your desktop.  When you release the mouse key, click 
on "Create Shortcuts Here" from the pop-up box.  Click on the shortcut  to open the 
application, file, or folder.

46 Drag the bar between the two windows of the Explorer window to change the size of 
either side.

47 Click once on a folder in the Explorer's left pane to display its contents in the right pane.
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48 Double-click on a folder to open or close it.

49 From within the Explorer, use the keyboard's arrow keys to highlight folders instead of 
clicking with the mouse.  A "+" next to a folder in the left pane indicates that there are 
folders within the folder.  Hit the plus key on the numeric keypad to open it.  A "-" means 
that the folder is open.  Use the minus key on the numeric keypad to close it.

50 Use the Tab key to move between the left and right panes of the Explorer.

51 Press F6 to switch between the panes in an Explorer window.  

52 Press the backspace key in an Explorer window to go up one level in the hierarchy of 
folders.

53 To move a file between folders on the same drive, select the file (see tip 47) in the right 
pane of the Explorer by clicking on it.  Then use the left pane's scroll bar to look for the 
destination folder.  Drag the file from the right pane to its new folder in the left pane.

54 To move a file to another drive, select the file in the right pane, press Ctrl+Shift, and drag 
the file to the target drive.  After you release the mouse button (but not the Ctrl and Shift 
keys), choose Move Here from the pop-up menu.

55 To copy a file to another folder on the same drive, highlight the file's name in the right 
pane, press the Ctrl key, and drag the file to its destination folder.

56 To copy a file to another drive, highlight the file's name in the right pane and drag it to the 
destination drive in the left pane.

57 To highlight all of a folder's contents, either select the folder with one click or open it with 
two clicks in the left pane.  Ctrl+A highlights contents of the right pane.

58 When viewing files by large or small icons (go to the menu bar and choose View and then
Large Icons or Small Icons), you can highlight a rectangular area of icons in the 
Explorer's right pane by clicking on the upper left icon, holding down the Shift key, and 
clicking on the lower right icon.

59 Click next to (not on) an icon and drag the mouse diagonally over the rest of the items 
you want to highlight.  You'll see a dotted-line selection box appear around the items as 
you drag.  This works best in the Large Icons or Small Icons View.

60 To select non-contiguous icons or object names in the Explorer's right pane, press the 
Ctrl key and click on the icon or name of each item you want to select.

61 To rename a file, folder, or application, click on a file's name and press F2.  A solid black 
box appears around the filename.  In the box, type a new filename.  You can also right-
click on the icon and select Rename from the pop-up menu.

62 To search for a specific file or folder, highlight a drive or folder, select Tools from the menu
bar and under Find, click on the Files or Folders submenu.

63 For more sophisticated searches from the Find screen, click on the Advanced tab to 
search by file size and file text contents.
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64 Pressing Ctrl+C copies a file, folder, or drive to the Clipboard.  Place your cursor where 
you want to place the copy.  Press Ctrl+V to Paste it into place.

65 To quickly copy a file to a floppy disk, right-click on the filename, choose Send To from 
the pop-up menu, and then click on drive A: or drive B:.

66 Go to the Explorer's menu bar, choose View, then Details.  In the right pane, click on 
Name to bring the files -- listed in reverse alphabetical order -- to the top of the list.  Click 
again to bring folders -- in alphabetical order -- to the top of the list.  This only works when
viewing folders by Details.

67 To see files in chronological order, choose View from the Explorer menu bar, then Details.
In the right pane, click on Modified to arrange files in chronological order.  Click on 
Modified again to see reverse chronological order.

68 In the menu bar, click on View, then click on Status Bar.  Open a folder in the right pane 
and look at the bottom of the window to see the number of objects in the folder and their 
combined size.

69 In the Explorer window, click on View in the menu bar and choose Status Bar.  Then click 
on any item in the menu bar and release the mouse.  Now, when you drag the mouse 
across the menu items or across items in the pull-down menus, you will see a helpful 
description of what the item does displayed in the Status Bar, which is at the bottom of 
the Explorer window.

70 Click on a folder or filename to highlight it, and then press Shift+Delete to delete the item.

71 Create a shortcut to the Explorer and customize it to take you to drive D:.  Go to My 
Computer and locate the Windows folder.  Drag the Explorer to the desktop to create a 
shortcut.  Then select the shortcut and press Alt+Enter.  Click on the Shortcut tab.  In the 
Target box, enter C:\WINDOWS\EXPLORER.EXE /e,/root,d:\ and click on OK.  Rename 
the "Shortcut to Explorer" icon "Shortcut to D drive" so you know what it does.

72 Open a folder from My Computer in Explorer View by clicking on a folder in My Computer,
then shifting and double-clicking the folder.

TROUBLESHOOTING

73 Right-click on the Recycle Bin and choose Empty Recycle Bin from the pop-up menu.  
Deleting unwanted files this way may solve a Disk Full problem.

74 Quit programs you don't need and close unused windows if you get a message saying 
you're out of memory.  If that doesn't work, restart the computer.

75 Double-click on the My Computer icon on the desktop, then click once on a disk, such as 
the C: drive, and press Alt+Enter to see how much free space is left on the disk.  Or, you 
could find the C: drive icon, right-click on it, and choose Properties from the pop-up 
menu.

76 From the Desktop, Press F1 to bring up the Help Topics window; click on the Contents 
tab.  Then double-click on the Troubleshooting icon and double-click on "If you have a 
hardware conflict."  A series of hardware troubleshooting dialog boxes will guide you step 
by step.
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77 Click on the Start button in the Taskbar; choose Setting from the menu bar and then 
choose Control Panel.  Double-click on the System icon in the Control Panel icon and 
click on the Device Manager tab.  A peripheral that isn't working will have a red x over it.  
Double-click on that icon for an explanation of the problem.

78 To make an emergency startup disk, go the Control Panel icon, double-click on 
Add/Remove Programs, and click on the Startup Disk tab.  Put a high-density disk in 
drive A: and click on Create Disk.

79 One way to use the emergency disk: Put it in drive A: and turn on your computer.  At the 
A: prompt, enter SCANDISK C:/AUTOFIX and press Enter.  After this program runs, take 
the diskette out of drive A: and try to start your computer again.

80 To see how your computer is using memory, what devices you've installed, and which 
ports they're connected to, right-click on My Computer and choose Properties from the 
pop-up menu.

81 If you're having trouble getting a DOS program to run, you can make it run in a strictly 
DOS environment.  First, create a shortcut to the DOS application, then right-click on its 
shortcut and choose Properties from the pop-up menu.  Click on the Program tab in the 
window that appears.  Click on the Advance button.  Check the MS-DOS Mode box.  
Click on OK.

82 Double-click on My Computer; right-click on the drive C: icon, and choose Properties 
from the pop-up menu.  Click on the Tools tab in the Properties window that appears.  
Click on the Defragment Now button to defragment your hard disk.

83 In the Start menu, under Programs, click on the DOS Prompt icon.   At the DOS prompt, 
enter MSD (for Microsoft Diagnostics) and press the Enter key.  Diagnostics give a report 
of your system's configuration, such as how many COM ports you have or what your port 
addresses are.

84 Press F4 as soon as you hear the computer's startup beep to start Windows in safe 
mode, that is, with the minimum number of drivers needed to operate.

INSTALLATION

85 Install Windows 95 from Windows 3.1, not from the DOS prompt.  If you don't have 
Windows 3.1, install it from DOS.

86 Get out a new floppy and copy your AUTOEXEC.BAT and CONFIG.SYS files onto it, as 
well as all your .INI, .GRP, .PWD and .DAT files before you install Windows 95.

87 Turn off DOS screen savers before you install Windows 95.  A screen saver can cause 
problems during setup if it comes on.

88 Before you install Windows 95, remove Norton Anti-Virus Version 1.5 or earlier and 
Norton Desktop for Windows Version 3.0 or earlier.

89 If you've installed the Central Point Software virus protection utility VSAFE in your 
AUTOEXEC.BAT file, remove any lines that contain VSAFE.COM or VSAFE.SYS from 
the AUTOEXEC.BAT or from the RUN= line in your WIN.INI file before you install 
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Windows 95.

90 Read the file SETUP.TXT on your Windows installation disks or CD-ROM before you 
install Windows 95.  The setup file gives a list of programs that might conflict with the 
operating system, and tells you what to do to get the programs to work.

91 Install Windows 95 in a different directory from the one containing Windows 3.1 so you 
can start up from either program.  You'll have to reinstall all the programs you need to run
under Windows 95, though.

92 Press F8 at the startup beep to get into Windows 95 if you've set up your computer to 
boot from either Windows 3.1 or Windows 95.

93 Run MSD (Microsoft Diagnostics) and print out its report, so you have a record of exactly 
what’s in your system before installing Windows 95.

94 Before installing Windows 95, remove from your CONFIG.SYS and AUTOEXEC.BAT files
any TSRs that might conflict with the operating system.

95 Find the emergency DOS startup disk you made when you installed DOS.  Test it to make
sure it restarts your system in case the hard drive won't boot.  Do this before installing 
Windows 95.
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